Using the Reading List Service

System Link: library.universityofgalway.ie/galwayreadinglists
Support: library.universityofgalway.ie/teaching/readinglists
Contact: readinglists@universityofgalway.ie
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o  When | attempt to link my reading list to the module | cannot find the
module listed on the hierarchy page

Can | link a reading list to more than one module?

Can more than one lecturer share a reading list?

Can | copy a reading list?

Can | delete a reading list?

Do | need to recreate the reading list each year?

Is the reading list URL permanent?

Why are some of my core books not available as e-books?
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1. Opening the Reading List Service
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e Go to library.universityofgalway.ie/galwayreadinglists
e Log in with your usual University of Galway username/password.

e You will be prompted to create a quick user profile. You must make your profile
public so that the library can pass ownership of lists to you

Reading Lists

Home My Lists My Bookmarks Reviews  Feedback Admin *  Reporis «

2. Create a New List & Link to Module Hierarchy (Canvas)

1. To create a new list, go to the My Lists and click on Create New List on right of
screen.

2. You will be prompted to give your list a name: this should be Module code and
Module title, e.g. TLC100 The Learning Centre. You can also give the list a
description if you like.

3. Click on the Select Hierarchy button to link this list to the specific module(s) it relates
to. This is very important as this is the mechanism by which your list is linked with
your Canvas course/module.

a. Enter the module code in the search box and select the relevant module from
the list displayed.

b. Make sure to Save your choice.

c. Note: you can link a reading list to as many modules as necessary. If you have
any problems finding the correct course/module please email
readinglists@universityofgalway.ie

d. If required afterwards you can change/add module links to hierarchy using
the Edit pulldown module. See Section 15: Changing the Linked Modules &
Student Numbers

4. Select the relevant academic year within which this module will be taught.

5. Indicate the anticipated number of students taking the module(s) — this will help the
library to assess how many copies will be needed of the books on your list.

3. Structuring your List — add paragraphs and sections

It is better to create the structure of your list initially so you can then quickly add books
and journals articles when you start to bookmark resources from the Library Catalogue.
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You can create different sections in a variety of different layouts e.g. General Reading,
Primary Reading, Week One, Week Two, By Topic etc.

3.1 Adding Paragraph and General Information to your Reading List

At any stage within the reading list you can add in information about the module,
assignments, learning outcomes or general advice for the students. You should be
able to replicate all information provided in a MS Word Reading List that would
traditionally have been given out.

1. If the list is not open go to My Lists and select your list

2. To add a paragraph information click on the paragraph link that is visible in
the Empty List! box.

Empty list!
Start by adding one of the following items

Add resource Add paragraph l l Add section

3. Now fill in any details you wish to provide about the list or module.

BIU ===

4. You can cut and paste in any existing descriptions from a word document and
format as required.

3.2 Add a section to a reading list
e.g. Core Texts, Primary Reading, Secondary Reading, Week 1, Week 2, Topic etc

1. Click on the section Link as above within the Empty List! Box
2. If the Empty list! icon is not visible (as above), move your mouse up and down
the screen and the Action Bar will appear:

p— ADD RESOURCE ADD PARAGRAPH ADD SECTION —

3. Select ADD SECTION
You'll be asked to give the section a title e.g. General Reading, Topic name,
Week and optionally, a description. Click on Save.
i. You can add as many sections as you like to your list. You can add
subssections within sections to allow for detailed breakdown of
resources if required.
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ii. The: menu option at the end of the section line allows you to edit,
delete or move the section within your list.

4. Adding Resources - add the Talis Bookmark Extension to your Browser

Once you have created a structure you can add different resources by
bookmarking.

To do this, you can use a Talis Extension bookmark tool which makes adding
references much easier and quicker.

For ease of use and for security reasons, the Talis extension is the recommended
method of adding references to your reading list. It replaces the “Add to your
Bookmarks” button which may not be as dependable across all interfaces.

To install the Talis Bookmark Extension

1. Locate the Talis Aspire Reading Lists Bookmarking extension in the Chrome web store.

2. Click Add to Chrome. A popup will appear confirming you'd like to add the extension to
your browser

3. Click Add extension. You should now see the Talis logo appear along side your other
extensions (such as Endnote).

4. The first time you attempt to use this extension it will prompt you to select your
institution - click the dropdown and select University of Galway from the list, then
click Save.

5. Finally you can click on the Pin icon to make Talis extension icon visible on your Browser
bar.

5. Bookmarking a Book from the Library Catalogue

e Go http://library.universityofgalway.ie

e Search for your book on the Library Catalogue. In our example we have searched for
‘Byrne and McCutcheon on the Irish Legal System’ by Raymond Byrne.

¢ Find the book on the Library Catalogue and open the record as shown

® (Click on the Talis Bookmark Extension located next to the browser address bar
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o The bookmarking screen opens — follow instructions below.

it anniversary edivan, ighth edition

ISEN-10
1532650232
158M13
9781532650337
Femove

Pub place

Wayne. N

e Do a quick check of the bibliographic information to ensure accuracy (edit fields if necessary)

o [fit an e-book make sure that the Online Resource box is ticked

e Click on Create and Add to List

e Select your reading list from the drop-down menu

e Choose what section (General Reading etc) to directly add the book to and add notes for
students at this point.

e Select if the book is for Student Purchase/Core OR Recommended. We will purchase the
maximum copies based on student numbers if Student Purchase/Core

e Click on OK to finish

e You are returned to the Library Catalogue to continue bookmarking resources.

6. Bookmarking an e-book from the Library Catalogue
The steps for adding an e-book to a Reading list are similar to adding a print book.

e Find the book on the Library Catalogue, open the record and click on the Talis
Bookmark Extension.

e The Reading List System will detect if both the print and e-book is available and bring
up the following choice of which format you wish to bookmark.

e Click on the e-book version of the book and follow the same steps for adding to the
Reading List
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Online
Title Lookup Identifier Author Edition Year Format resource

Byrne and McCutcheon on the Irish 9

legal system

Byrne and McCutcheon on the Irish
legal system

Note: you can combine the print and e-book records to show the print holdings and link to
the e-book from the same bookmark.

To do this Bookmark the print book. Then Edit the Bookmark and add in the url of the e-
book as a web address using the ADD FIELD pulldown menu. Make sure to tick Online
Resource.

7. Bookmarking a Book that is not listed on the Library Catalogue

If you wish to order a new book and you find that it is not listed on the Library Catalogue
then you can bookmark from another website such as Amazon or WorldCat or even a
publisher’s website.

Example: Bookmarking from Amazon

1. Go to www.amazon.co.uk

2. Locate the book and click on the title to display details— it is important to have only

the bibliographic details of only the required book displayed

Click on the Talis Extension button and add the book to the appropriate reading list.

4. Please indicate whether the book is Core or Recommended. The Reading List Team
require this information in order to purchase the appropriate number of copies.

w

8. Using the Quick Add Resource Button to Add books

This method allows you to add books from within your Reading List. This method is less
favoured by us then using the Talis Book extension (see Section 4) because often it does not
link accurately with our Library holdings or e-books links.

1. Open the Reading List you wish to add books to. Move the cursor up/down the reading list
to make the Action Bar appear.

— ADD RESOURCE ADD PARAGRAPH ADD SECTION =———

2. Click Add Resource on the Action bar.

3. This will display a search screen that allows you to search your existing bookmarks, as well as
books on Nielsen Book Data.
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Return to Study Handbook

4. Select the book you wish to add to your list by clicking the title.
5. This will expand in line with the other search results to show you details of published
editions, as well as their stock status in your library catalogue.

Study Skills Handbook

....... me Book - by Stella Cottre

Edition

5th edition

5th edition

5th edition

4th edition 9781137289254 2013 v [+]

3rd Revised ~ _ Paperback /

edition F/ERasts st A softback

how mon

6. Locate the edition you wish to bookmark and click the plus button. This will add the items to
your list, as well as to your 'My bookmarks'.

9. Bookmarking a Journal Article

1. Locate your article through the Library catalogue / database / website
o The Library Catalogue search includes articles, so this is usually the quickest
method of finding our subscribed journal articles
o Once the article is located click on the journal title and open the article from
the fulltext link
2. Itis best to bookmark the HTML page which links to the full text PDF of the article
and NOT the PDF itself. The Reading List System will not capture sufficient
information to create a good bookmark from a PDF but will from the HTML version
of a page or the abstract page.
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3.

Click on the Talis Extension Button. The following screen is displayed

Home My Lists My Bookmarks Feedback

Bookmarking from Oxford Journals and similar

Article | | Is part of Journal

Resource Type
Aticle v ~
Title *

[Munich Alumni and the Evolution of Intemational Human Rights Law__

Author (first name, surname)
T Rensmann Remove | Single Field

Date
0171172011 Tl Remove

ool
10.1093/ejilichr073

Online Resource: || Add field: | Author V| Add| Lookup: [DOI V|| Lookup|

Note

TS cancel

10. Setting Item Importance

Each item on a reading list can have its importance flagged to students. Three importance

levels are available:

1.

Core/Suggested for Student Purchase (equivalent)
Recommended
Further Reading

The library will presume that any books flagged as Core are essential reading for all
students of the module and will acquire sufficient copies and assign loan status
relative to class size on that basis.

Recommended should be used where an item is considered useful additional
reading, but it is not anticipated that every student will read this work. The library
will ensure that one copy of a recommended books is available.

Further Reading indicates that students may find this work broadly relevant if they
wish to expand their own research on the topic. The Library will try to ensure that a
copy of this work is available.

Notes can be added to each item for both the students and the library. The student
notes can be used to given reading guidance to the student — e.g. what they will get
from this work, or the relevance of the work to particular essay topics, etc.

Library notes can be used to communicate with the library about requests for
scanning and other useful information that will help the Library ensure student
access. For example, it would help to know if purchasing print copies was unsuitable
because the course was being run off campus.
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11. Bookmarking a Book Chapter for Digitisation

1. Search and find the book in the Library Catalogue (select
2. Click on the book title to view the individual record

3. Click the Add to My Bookmarks Extension on browser address bar.

The study skills handbook Chagtar | Is part of Bock

4. At bottom of screen select Add field and choose Has part from the drop-down
menu . The Screen on right is displayed.
5. Enter chapter information
a. If the chapter has separate author and title etc. use the Add Field menu
to add in the bibliographic fields e.g. author, chapter title, page range etc
b. Otherwise gave the basic Chapter information in the title e.g. Chapter 3
of The Study Skills Handbook
6. Click Create & Add to List. Specify where in the list the bookmark should be
added.
7. Enter any information in the Note for Student field and set the level of
importance
8. Following publication of the list, the Library will first of all check for an e-book. If
an e-book is not available we will request the chapter is digitised by the Library

Digitisation Centre. This is subject to existing copyright regulation.

12. Checking and amending your List before Publication

It is good practice to review the list before you publish. You can:

e make any necessary amendments or changes to sections
e amend any resources that are not displaying as you would like
e add resources that you have stored in your bookmarks

To amend the list:
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e Go to My Lists and select the Reading List
e Use the Action bar that appears to edit or add new sections to your list if necessary.

— ADD RESOURCE ADD PARAGRAPH ADD SECTION —

e Because you have created Bookmarks, now when you click on ADD RESOURCE your
stored bookmarks will appear. These can added again if required and edited to
identify specific chapters for example

e Note you can move bookmarks between the sections by grabbing the $ icon with
your mouse

e You can edit a bookmark by clicking on the : menu on right of bookmark. You can

o Edit the bibliographic data that appears if required
o Change the student note that appears beneath the Bookmark
o Carry out other useful functionality

13. Talis Engage and Upload File Function

Talis Engage enables lecturers to upload files for students to view directly within their
reading lists.

It permits students to annotate these resources if required. A variety of file types can be
uploaded.

You can manually create a bookmark for lecture slides or class notes and upload these to
the reading list (Select My Bookmarks and Add).

Note: in order for the Upload File option to appear, the hierarchy code must be present on
the reading list for copyright checking and reporting purposes.

Uploading a file

Click on the Action button (three dots) next to the list item in question. You will need to
select 'Upload file":

Drag or select the file from the folder where it is saved.
You can decide whether or not students can comment on the file that's been
uploaded, and whether they can download the original file for personal use.

3. These settings can also be changed later if necessary.
If you upload a book chapter or an article you will be asked for chapter and pages
details as part of the copyright check.

James Hardiman Library Reading List Service Guide 10



5. Click on Submit

a. If thereis no copyright issue, you will get a notification that your file is now
live. Refresh the page to see the newly added Talis Engage item.

b. If there is an issue with the request (e.g. numbers of pages digitised may not
be covered by the ICLA licence) then the request will be referred to library
staff for copyright checking. If the request meets copyright criteria then it will
be accepted and the online link will appear in the item.

6. The list item will now feature a 'View Online' button. Students can click on it to view
the resource within the Talis Engage interface.

14. View the Reading List as the Student Sees it

It is good practise to view the list as the student sees it to identify any issues and check links
that you may be unsure will work.

e Go to My Lists and select the Reading List
e Open the View dropdown menu and select “As Student” —see image below

e The Student View displays

l Edit ~ ” View - I + My Lists

15. Publishing Your List and What Happens Next

A list is not available to students until you publish it and you will be unable to link to it from

Canvas.

1. From My Lists:
2. Open the Reading List
3. Click on the Publish icon in the top right corner
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What happens Next

1. The Library will be notified and will review the list for:

e purchasing of new and additional titles (inc. e-books)

e changing loan status

e chapter/article scanning requests based on information in the list
The list is live and is searchable from the reading lists home page
The list link can be added to Canvas.

See section 10 if you wish to edit/amend the list again

vk N

Note: If you edit a list after it is published you need to click Publish again for the
changes to be visible to students.
6. If you do make changes you can also leave the list in draft until you are ready to

publish and make the updated list available

16. Enable the Library Reading List Link in Canvas

1. Within each module/course on Canvas, select Settings

2. Selectthe Navigation Tab

3. Locate the Library Reading List option and then click Enable

4. Move the list link to an appropriate position within the Course Navigation and
click Save

5. Library Reading List now appears in the main navigation menu

6. Click on Library Reading List (you may need to authenticate)

7. Locate the reading list for the current academic year (as below) and click on

Embed
8. Thereading listis now linked (you also have the option to relink to a different list)

Embed reading list from Talis Aspire

ST Lo I v, (il Crmalcn i i

ACADEMICYEAR 3005006 500208

SCEE Inirosec e Lo AocownLeg yrbag] i

FCESDY Introdhactie te dooousvting Embad gt

Note: If you are asked to use the search box to find the correct list then the module
code may be missing from the Reading List.
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Please see Section 17 -Changing the Linked Modules (Courses) & Student Numbers on
how to add the module code to the reading list. Note If the module code is not
appearing when you search for it, please email readinglists@universityofgalway.ie

(this may happen for new modules)

Please go back to Step one above when the module code is added

17. Linking to Reading List Section from Canvas

You can choose to display sections of the list in specific courses/modules within Canvas.
You can choose this option in addition to linking to the full reading list. Alternatively, you
can disable the Reading Lists menu option if you don’t want students to see the whole
reading list (select Settings on the Course Navigation menu, click the Reading Lists
settings icon and select Disable, then Save).

1. Inyour Canvas course, click Modules.
2. Click the + sign within the chosen module in Learning Materials.

i v Learning Materials °

3. Select External tool from the drop-down list.

4. Click Reading Lists and change the Page Name to something more meaningful
(eg, Week 1 Readings). Do not change the URL.

5. Click Add item, this returns you the list of modules.

6. Identify the newly added module and click.

7. “Add list section” will appear. This will allow you to search for your list in Talis,

and select the section to be linked to the module. The search box defaults to the
name of your Canvas course.

8. Iftheincorrect list is displaying, type the course code in the search box and select
the correct list with the correct teaching period from the drop-down results.

9. Select the Talis list section you want to add from the drop-down list. N.B if you
wish to link to the whole list select the list from the drop-down menu.

10. Click Save. The list section will now display in Canvas.

11. Return to Courses and repeat the above steps to add other sections of the list.

12. To ensure that students can view your Modules you will need to publish each
one by clicking the cloud icon at the right hand side of the module.
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18. Changing the Linked Modules (Courses) & Student Numbers

One common reason why lists do not display in Canvas is because the module was not
linked correctly to the reading list. Alternatively you may want to link another module to the
reading list.

In addtion having student numbers for each module is a great help for us to purchase the
correct number of copies. It may slow up processing your list if this is not in place. To check/
edit the links to your reading list or change student numbers:

1. Open the reading list in question

2. Open the Edit pull down menu and select ‘Hierarchy and Student Numbers’

3. Search for the new module in the grey search box and make sure to select Save.
4. Please add in the approximate number of students that will be taking the module.

This helps us in deciding the number of copies to purchase.

19. Best Practice for Reading Lists

Reading List Principles

e Have a clear reading list structure, with resources presented weekly, or by topic

e Use annotations where needed, pointing out key sections or clarifying page
numbers e.g., "Chapter 2 gives a good overview of this topic"

e Set realistic expectations by indicating what is Core, Recommended, or Further
Reading

e Be realistic with the number of resources given, overly long lists can be
overwhelming (see section below)

e The list should be reviewed annually. Books on your list will not automatically
update when there is a new edition so regular checking needs to take place

e Reading List Usage

e The View button on the Reading List Module Page contains an Analytics option
where you can see how many times students have accessed each item on the
reading list. This tool can help identify list items for review or removal.

Diversifying Reading Lists

A primary aim of the Library Strategy for 2021-2025 is to increase diversity in the
Library's collections. To facilitate this inclusive collection building, we ask that
academic staff consider the following when creating module reading lists:

e can you include more readings by minority academics and scholars?

e arethese readings always optional or can some be made core?

e can you ensure that readings by minority writers and scholars are not only included
when the topic is about marginalised groups?
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e if this proves to be difficult, can you include readings about the lack of diverse
representation in the subject area?

20. Frequently asked questions

a) When | attempt to link my reading list to the module | cannot find the module listed
on the hierarchy page

b) Canllink a reading list to more than one module?

c) Can areading list be shared if a module has a number of contributing lecturers?

d) Can |l copy areading list?

e) Can | delete a reading list?

f) Dol need to recreate the reading list each year?

g) Is the reading list URL permanent?

h) Why are some of my core books not available as e-books?

a) When | attempt to link my reading list to the module I cannot find the module
listed on the hierarchy page

Some newer modules will not be listed on the Reading List System yet. Please email any

missing module codes with module titles to readinglists@universityofgalway.ie and we will

quickly add them for you.

b) Can I link a reading list to more than one module?

Yes. If your list is being used by a number of modules, add the module codes in the
Hierarchy & Students search. Please also add in the students’ numbers for each
module.

c) Can areading list be shared if a module has a number of contributing lecturers?

Yes. If your module has a number of contributing lecturers you can invite lecturers to
become publishers on the module. See below.

e Open the reading list and select Edit. Select Invite List Publishers from
the List.

e You will be asked to enter in the lecturer(s) email. An invite will then be
sent. Once accepted, the lecturer will be able to edit and update the list.
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d) Can I copy a reading list?
You can copy a reading list and amend as required.

e Goto ‘My Lists’.

e Find the list you wish to copy.

e C(lick on the Actions button on the right and select ‘Copy to a new list’

e Note at the end of the academic year the reading list will automatically roll over
for the new academic year so the copy function is not required in this instance.

My Lists Showir 11 Y Of | t Action = I Create new list |

2]

[ itle ¢ AcademicYear  Linked to Status Last updated . Action

e) Can |l delete a reading list?

In practice there is rarely a serious need to delete a published list. You can archive the
list using the Edit pulldown menu and remove it from the course search and My Lists
screen. If you do wish to delete a list please email readinglists@universityofgalway.ie
with the module code.

f) Do I need to recreate the list each year?

No. The list will automatically rollover during the summer. Please note that only
published versions will roll forward. If you are updating a list for the new academic year
please publish it and ensure that the most up to date version rolls forward.
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g) Is the reading list URL permanent?

The Reading List URL is permanent. The link can be copied to other resources and
applications e.g. AKARI or an email etc.

h) Why are some of my core books not available as e-books?

We will always check for an e-book if the book is listed as core. Unfortunately, many
publishers that offer individual e-book purchase will offer limited or no e-book
availability to libraries.

Collection Development 10/09/25
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